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EIS and the NEI

Emission Inventory System (EIS)
— Data repository for air emissions data used to create the NEI
— Contains State, Local, Tribal and EPA submitted data

— Can be multiple emissions values for the same
FIPS/pollutant/process

— Annual, monthly, episodic, daily data

— Data available via a password-protected web site
« EIS Gateway https://eis.epa.gov/eis-system-web/welcome.html

National Emission Inventory (NEI)

— Snapshot in time from EIS

— One emissions value per process selected

— Typically S/L/T data used preferentially

— Typically NEI only contains annual emissions values




S/L/T Reporting Requirement

« Air Emissions Reporting Rule (AERR)
http://www.epa.gov/ttn/chief/aerr/
— Complete criteria pollutant inventory every 3 years

 All point sources (emission threshold based on potential to
emit)

Nonpoint sources

Onroad and Nonroad sources

Events (wildfires and prescribed fires)

2011 Emissions due 12/31/2012, EIS window opens
6/1/2012

— Annual reporting for type A point source facilities
» Point source emission thresholds are higher

— HAPs are submitted voluntarily by many S/L/Ts and
are encouraged as part of an integrated report
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Uses of the NEI

 The NEI is one of the key inputs for :

— Modeling of national rules
* NAAQS reviews, CSAPR, etc

— Non-attainment Designations
— NATA Review — toxics risk modeling
— Trends reports and analyses
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Components of the EIS

o Six different data categories
— Facility Inventory
— Point Emissions
— Nonpoint Emissions
— Onroad Emissions
— Nonroad Emissions
— Event Emissions (wildfires and prescribed fires)

— No biogenic emissions, although these are part of
EPA’s modeling files
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What are Nonpoint Sources?

Stationary sources that individually are small and numerous,
and that have not been inventoried as specific point or mobile
sources.

These sources are grouped in such a way that they can be
estimated collectively using one methodology. Examples are;

— Residential heating

— Consumer solvents

Also includes

— Commercial Marine Vessels
— Locomotives

— Paved roads, unpaved roads
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Commercial Marine Vessels

S/L/Ts should not report emissions for ships in Federal
Waters

— We will use EPA estimates for all ships in federal waters

Emissions must be reported at the shapelD level in
counties where appropriate shapelDs exist. Use the
EIS shapelD library under reporting codes

Emissions Type Code is required (indicates cruise,
hoteling, maneuvering, refueling and reduced speed
zone)

Anytime EPA data exists for a
shapelD/SCC/poll/emistype combination that does not
exist in the submitted data, both will be selected and
may cause double counting.



| ocomotives

« Rall yards are preferred to be reported as points.

e Line haul class 1 and class 2/3 rail emissions
must be reported at the shapelD level in
counties where appropriate shapelDs exist.
Use the EIS shapelD library under reporting
codes
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How do | report using
shapefiles?

- —— - . - =Ho)
e' '|§7‘ https://eis.epa.gov/eis-system-web/code/sta O ~ @ B ¢ X H 2 s x
x Go g[L’ - "‘ Search = - More » Signln 9 -
» Reporting Code Tables = L LR R T —— -
\ Event Classification Code Table of codes that identify the classification of a fire.
» QA Checks Event Size Source Code Table of codes that identify methods used to determine the size of an event.
» View Dataset |dentifiers Event Stage Code Identifies whether emissions reported are due to flaming, smoldering, or both.
Facility Category Code Code that identifies the Clean Air Act Stati Source designation. E include major, minor, and synthetic minor.
» Inventory Cycle Management FRCRIE il ! el
o7 Facility Site Status Code Code that identifies the operating status of the facilty site.
» EIS Br‘dge Facility Source Type Code Category or source type of a facility for EIS classification.
SUPPORT Fuel Configuration Code The predominant configuration of the fuel burned (i.e., pile, windrow, broadcast or natural).
FuelC ion And Emissions Model Code Code that identifies the unit of measure for the amount of fuel consumed.
» Administration Console Fuel Loading Unit of Measure Code Code that identifies the numerator of the unit of measure for the fuel loading.
» View All Announcements Fuel Selection Code The methoed used (on-site survey vs. GIS overlay) to select the appropriate fuel beds (e.g., red spruce, chaparral, sawgrass, or logging slash).
Fuel Type Model Code The fuel model used to characterize available fuel beds (e.g., FCCS or NFORS).

» View Support Requests - - - - - - -
Geographic Referance Point Code The code that represents the place for which gecgraphic ceordinates were established. See www .epa.govioeil for mere information en the proper uzage of

» Create Support Request this code set.
The code that reprezents the geometric entity represented by one point or a seguence of latitude and longitude points. See www . epa.govioel! for more

Geometric Type Code

ACCOUNT DATA information on the proper usage of this code set.
Ground Based Data Source Code Indicates whether ground-based data were included and if so, identifies their source
» My Account p — -
Heat Release Unit Of Measure Code Code that identifies the unit of measure for heat release.

m

» My Agency

The code that identifies the method used to determine the latitude and longitude coordinates for a point on the earth. See www.epa.govioel for more

KonzontallColle cionie nid{Code; information on the proper usage of this code set.

» Account List

. The code that reprezents the reference datum used in determining lattude and longitude coordinates. See www epa.govioei for mere information on the
Horizental Reference Datum Code

» Current Users List proper usage of thiz code set.
» Account Request List Igniticn Location Code The lpcation and distribution of the ignition peints within the burn area (e.g., center or multiple).
. i Igniticn Method Code The methed used to ignite the fire (i.e., DAID, helitorch, or driptorch).
» AgenCY Organlzatlons Ignition Orientation Code The technigue used to direct the crientation of the fire's movement with respect to the wind (i.e., backing, strip-heading, or flanking). —
CONTENT MANAGEMENT | Location Address State Code The alphabetic codes that represent the name of the principal administrative subdivision of the United States, Canada, or Mexico.
Location Type Code Identifies the type of code or identifier that iz being excluded.
» Messages NAICS Code The code that reprezents a subdivision of an industry that accommedates user needs in the United States.
» Application Configuration m The code for the pollutant which is controlled by the control measure.
Y Port dentifiers The code that identifies a shapefile of type port.
» Create Announcement ‘ \ P fypep

Railway Segment Identiﬁg‘rs/ The code that identifies a shapefile of type railway segment.
The code that describes the regulation applicable to the emissions unit activity or process.

» Logout

Releaze Peint Exit Gas Flow Rate Unit of Measure Code  The unit of measure for the stack gas flow rate value.

Release Point Exit Gas Velocity Unit of Measure Code The unit of measure for the velocity of an exit gas stream valus.
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Releaze Point Status Code Code that identifies the operating status of the release point site. -
- - - — — p
— = G‘“ \ hgjl &II e -, i 11:21 AM
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E - . —— - [rp—— p—. [ = ¥ &J
a'- l|.§’ https://eis.epa.gov/eis-system-web/shape/li: 0 ~ @ B ¢ X H S s X ook
: x Go gk’ - '.'l Search = - More » Signln 9 -
g T eaes Shape Identifier Port Hame #+ Fips Code Area in square miles -
U E Monpoint/ Onroad/ Nonroad 10000 Albany 36001 (Albany, New York) 0.3878655
missions 10004 Alpena 25007 (Alpena, Michigan) 0.04240724
» Event Emissions 10002 Anacortes 53057 (Skagtt, Washington) 008532005
» NCD Activity Data 10003 Anchorage 02020 (Anchorage, Alaska) 0.53040326
10004 /!!H!!'B'ma\ 39007 (Ashtabula, Ohio) 05104288
» Inventory Selection
10147 / Baltimore \ 24003 (Anne Arundel, Maryland) 0.47381672 i
REPORTS | 10148 ‘ Battimore ) 24005 (Battimore, Maryland) 2318912
10148 Baltimore / 24510 (Baltimore city, Maryland) 7160195
» Request Reports -
10005 ‘oint 15003 (Honolulu, Hawaii) 033698225
» Report Downloads 10006 Baton Rouge 22005 (Ascension, Louisiana) 55.918114
» Large File Download 10007 Baton Rouge 22033 (East Baton Rouge, Louisiana) ©66.67338
H Feedback Report 10008 Baton Rouge 22047 (lbervile, Louisiana) 65.31524
» Feedbacl Epors
p 10009 Baton Rouge 22121 (West Baton Rouge, Louisiana) 111.113855 =
» Agency Submission History 10010 Beaumont 48245 (Jefferson, Texas) 4858752
Report 10011 Beaumont 48361 (Orange, Texas) 026710904
REFERENCE DATA 10184 Biloxi, WS 28047 (Harrison, 0.19622037
10012 Boston 25017 (Middlesex, Massachusetts) 067535377
» Reporting Code Tables 10013 Boston 25025 [Suffolk, Massachusetts) 05823123
» QA Checks 10014 Bridgeport 09001 (Fairfield, Connecticut) 026778936
- 10015 Brownsville 48061 (Cameron, Texas) 2053423 [ 4
» View Dataset |dentifiers - d - L
10016 Brunswick 13127 (Glynn, Georgia) 0.3650601
» Inventory Cycle Management 10150 Buffalo 36029 (Erie, New York) 49257355
» EIS Bridge 10175 Buffingten, IN 18089 (Lake, Indiana) 0.19622037
10017 Burns Harbor 18127 (Porter, Indiana) 0.8401135
alcite resque Isle, Michigan)
SUPPORT 10018 Calct 26141 (P Isle, Michigan) 0.021764237
» Administration Console 10019 Camden 34007 (Camden, New Jersey) 0.38438213
10020 Cargquinez 08013 (Contra Costa, California) 0.11063455
» View All Announcements 10021 Catalina 05037 (Los Angeles, California) 4.4035678E-4
m » View Support Requests 10022 Charleston 45019 (Charleston, South Carolina) 047660846
» Create Support Request 10173 Charlevoix, M 26029 (Charlevoix, Michigan) 0.19622037
10166 Chattanooga, TN 47065 (Hamilton, Tennessee) 0.19622037
m ACCOUNT DATA | 10152 Chester, PA 42045 (Delaware, Pennsylvania) 0.10937001 i
@ > @J EII e A , l28AM o
{\a =2 E. 2B/012 ||




CMV and Rall

e Location
— State and County Code

— AND Shapefile Identifier (if exists in that
county)

 Emission Process
— State and County Code
— Shapefile Identifier (if exists in that county)
— Specific SCCs
— Emissions Type Code (CMV only)

-
<
L
=
-
O
o
(@
L
>
—
- -
o
o
<
<
o
L
2
=




CMV and Rail SCCs

i - — - . - =H[0!
6' X '|::,‘ https://eis.epa.gov/eis-system-web/code/sc 0 ~ @ B ¢ X H Sms 3 ‘ £
x Go g[L’ - "‘ Search = - More » Signln 9 -

"

EIS Gateway

Sally Dombrowski; EIS; Content Manager Role, Authenticated Role, Inventery Selector Role, Inventary Developer Role, Account Manager Role = . T : o . E
! B i S, ¥ I 11| = e - ERAT | i i ) : s e

| VIEW/ADD/EDIT |

Source Classification Code List

» Facility Inventory and Point Name: Source Classification Code SearCh On “Ra”” Or “Marlne

m

Emissions Description: The 8 or 10-digit EPA Code that describes an emiss . "
» Potential Duplicate Facilities Vessels Com merC|a|
Show entries !

» Merge Processes

| TR Eye E o CT
» Nonpoint/ Onroad/ Nonroad @ )
Emissions DataCategory % Code  ~ SCCLevelOne % SCC Level Two % S‘h:fe':“"" SCCLevelFour & MapTo £ LastinventoryYear ¢ Option Group & Option Se
» Event Emissions Line Haul ]
» NCD Activity Data Nenpoint 2285002008 Mobie Sources Railroad Eguipment Diesel Locomotives: )
Class | Operations
» Inventory Selection Line Haul
REPORTS Nonpoint 2285002007 Mobile Sources Railroad Equipment Diesel IE?;;;:F}WIES: =
Operations
» Request Reports
4 P Line Haul
» Repor‘t Downloads MNonpoint 2285002008 Mobile Sources Railroad Equipment Diesel Locomotives: -
) = Passenger Trains
» Large File Download [Amtrak)
» Feedback Reports Line Haul
Nonpoint Mobile Scurces Railroad Equipment Diesel Locomotives:
» Agency Submission History Commuter Lines W
REDOI’T Kl int FIRENANTINAN Mnhila Crnrcac Dailrnad i Nizeal Mard |l n i S

REFERENCE DATA |

Showing 1 to 5 of 5 entries (filtered from 11717 total entries) First Previous 1

» Reporting Code Tables
» QA Checks

Download Results: CSV
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z = EIS - Windows Internet Explorer, provided by EPA
m o A |ﬁ, https://eis. epa. qov/eis-syster-webfcode/lisk, htmlr codeMatadatald=40 V| ﬂ | 2| X |
E File Edit Wew Favorites Tools  Help
@Convert - Select
: W [QEIS I l c.éa  |::h Page - ’)} Todls ~ ?
O EIS Gatewa ]
O : y . i’ E?t -y
" Sally Dombrowski; EIS; Content Manager Role, Authenticated Role, Inventory Selector Role, Inventory Developer Role, Account Manager Role 1} ikl EEN
[ g3 i iL L G vk T W i ERERRRR L, i |1 | L —— e Sy 1 Sl EEtat] %
ﬂ | VIEWIADDIEDIT | | oge Table List View
» Facility Inventory and Name: Emissions Type Code
m Point Emissions Description: Defines the type of emissions produced by Onroad and Nonroad sources (e.q., exhaust,
» Potential Duplicate evaporative and tire wear) and mode types for commercial marine vessels (e.g., cruise and
} Facilities reduced speed zone).
| » Merge Processes a items found, displaying all items.
» Nonpoint/ Onroad/
Monroad Emissions Emissions Type Code Description Onroad Nonroad HNonpoint
» Event Emissions B Brake Wear ez Mo MNo
u o C Cruize No No Yes C——
m » NCD Activity Data E Evaporation Yes Yes Mo
» Inventory Selection H Hoteling No No Ves ¢
q R W Maneuvering Ne Mo Yes
EPORTS R Refueling No es No —
» Request Reports T Tire Wear Yes No No
q » Report Downloads X Exhaust Yes Yes o
z Reduced Speed Zone No No Yes —
& » Large File Download
» Feedback Reports 9 items found, displaying all items.
m _— Download Results: C3V
» Agency Submission
History Report
m REFERENCE DATA
’ » Reporiing Code
Tables 1
» A Cherks v H
Done ﬁ Lacal inkranet 100 v I
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Estimation of Emissions — EPA
Collaboration with States/Locals

Eastern Regional Technical Advisory Committee (ERTAC)
— First done for 2008
— Comprised of the SLT east of the Mississippi River and EIAG
— Kept the name ERTAC for consistency

Expanded to all SLT for 2011 NEI effort
— voluntary

Purpose
— Coordinate emission inventory needs for air quality modeling
— Develop and improve emission inventories

— Agree on methods, emission factors, and SCCs for developing default
emissions

EPA will develop emissions using these methodologies.
Complete all sectors by July 2012



Methodologies/Emissions Posted on Web

 Posted on EPA website when completed
— Somewhere on CHIEF, not sure where yet

— Posted files will contain methodologies, emission factors, activity
data, other info as appropriate

« SLT encouraged to review emissions and if emissions
ok, to not submit.
— Can indicate to EPA that you accept EPA emissions
— This would allow EPA emissions to be selected in NEI
 SLT encouraged to submit “better” data if desired.
— Also encouraged to use the same SCC
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Sectors EPA Will Estimate for 2011

e |CI Fuel Combustion (activity data will be released)

* Residential fuel consumption
— Coal (anthracite & bituminous)
— Distillate oill
— Natural gas
— LPG
— Kerosene
— Wood
« Paved roads
 Unpaved roads
« Commercial cooking
e Construction activites
— Road, residential, non-residential
 Mining and quarrying
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Sectors EPA Will Estimate for 2011,
cont.

 Solvents
— Architectural Coatings
— Auto Refinishing
—  Surface Coating - Traffic Markings
—  Surface Coating - Factory Finished Wood
—  Surface Coating - Wood Furniture
—  Surface Coating - Metal Furniture
—  Surface Coating - Paper, foil, and film
—  Surface Coating - Metal Can Coating
—  Surface Coating - Sheet, strip, and coil
—  Surface Coating - Machinery and Equipment
—  Surface Coating - Large Appliances
—  Surface Coating - Electronic and other Electric Coatings
—  Surface Coating - Motor Vehicles
—  Surface Coating - Aircraft
— Surface Coating - Marine
—  Surface Coating — Railroad
—  Surface Coating - Miscellaneous Manufacturing
— Industrial Maintenance Coatings
—  Other Special Purpose Coatings
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Sectors EPA Will Estimate for 2011,
cont.

» Solvents, Continued
— Degreasing
—  Dry Cleaning
—  Graphic Arts
— C&C: Cosmetics and Toiletries
—  C&C: Cleaning Products; Household
—  C&C: Auto Aftermarket
— C&C: Coatings and Related Products
— C&C: adhesives and sealants
— C&C: FIFRA Regulated Products
— C&C: Misc. Products (not otherwise covered)
—  Cutback Asphalt paving
—  Emulsified Asphalt paving
— Agricultural pesticide application

* Portable fuel containers

e Gasoline distribution, stage 1 & stage 2

* Aviation gasoline distribution, stage 1 & stage 2 (general aviation only)
 Open Burning (yard waste, household waste and land-clearing debris)
* Publically Owned Treatement Works (POTW)

» Agricultural Tilling
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Sectors EPA Will Estimate for 2011,
cont.

 Fertilizer application

e Livestock

e Cremation — human

« Dental Preparation and Use
 General Laboratory Activities
 Lamp Breakage (Landfill emissions)
 Lamp (Fluorescent) Recycling

 Oill and Gas Production
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Nonpoint Reporting Issues

« SCC Consistency
 Questionable Emissions Data
e Point Source Subtraction
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SCC consistency

Makes the merge of numerous datasets into the NEI easier.

EIAG wrote some rules to handle the issue of different data
sets having different SCCs for essentially the same process

— Unexpected results

EIAG working with ERTAC to Streamline the number of NP
SCCs

— No Changes for 2011 cycle

General vs Specific SCCs

— Never use SCCs to subtotal emissions

— Never double count emissions in your submittal
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Questionable Data
2008 Reporting issues

Unexpected pollutants

— Metals and PM-CON from fugitive dust sources
(paved roads)

— PM or Nox from evaporative sources
Ouitliers
— Extremely high values submitted
e 277 tons of 2,3,7,8 dioxin from waste disposal
Missing expected sources
— Fireplaces but not woodstoves
Errors in mass units (tons instead of pounds)
Reporting one month of emissions as annual



What you can do

* QA your submittal before submitting it.
— We will look at the data, but the more looks the better.

— Make sure reported units are correct

» EIS accepts many mass units, so you do not have to convert to tons to
submit.

« Compare to previous year or to alternative data (EPA data or
neighboring state)
— Divide current submittal by last year's number
» Graph ratio on x/y graph, look for values not on the x=y line
« Or can sort ratio and review real high and real low values

» If emissions are off by factor of 2000, might be a pounds to ton conversion
error

— You can catch many of these common errors by this comparison.
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Point Source Subtraction

Necessary to avoid double counting of emissions
— Regarding Point and Nonpoint

Responsibility of Submitting Agency to Reconcile Point
and Nonpoint

Some sectors do not need to be adjusted for point
sources
— Consumer solvents, residential heating

Others do

— Industrial Fuel Combustion, Industrial Surface Coatings



Point Source Subtraction

1. Activity based

Nonpoint activity = Total activity for sector — Sum
of Point source activity

Done at state level or county level
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Point Source Subtraction — Example
Calculation, Activity Based

e 73,665 E6GFT3 of Natural Gas used In the
iIndustrial sector (from dept of Energy)

— Represents total NG used in Industrial Sector for state

o Subtract out volume of NG used In the facilities
In the point source inventory (65,000 E6FT3)
— At state level, county level usage usually not available
 Remainder (8665 E6FT3) used in nonpoint
(area) inventory
— Allocate to county appropriately
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Point Source Subtraction (cont.)

2. Employment based

Nonpoint Employment = Total Employment
for source category — Sum of Point Source
Employment
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Point Source Subtraction — Example
Calculation, Employee Based

 Aircraft Surface Coating
— Emission factor = 15 |bs VOC/ employee

 Need Total Employment data

— Avalilable by county from the Census Bureau, County
Business Patterns

— Relevant NAICS
« 3364: Aerospace Product and Parts Manufacturing

 Need number of employees at Point source
facilities
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Point Source Subtraction — Example

Calculation, Employee Based

Sum the number of employees that work in the
facilities in your point source inventory in each
county

Subtract that from the number of employees

f

t
t

rom the Census Bureau for that county

"he remainder are the number of employees
nat are employed in the nonpoint sources In

nat county

Use the employee-based emission factors to
estimate emissions for each county



Point Source Subtraction (cont.)

3. Emissions based

Uncontrolled NP Emiss = Total Uncontrolled Emiss
of Sector — Sum of Uncontrolled Emiss of Point
sources

Not recommended for fuel combustion due the difficulty of
estimating uncontrolled emissions. Preferred approach
for fuel combustion is the activity (fuel throughput)
based approach.
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Point Source Subtraction — Example
Calculation, Emissions Based

* Dry Cleaners

— Have state level sales of solvents used at dry
cleaners

— Subtract out emissions reported at point
sources

— Remainder is emissions at nonpoint dry
cleaners

— Allocate to county using employment
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Break

Short Break — Back in 10 mintues
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EIS Format - Nonpoint Inventory
e 13 Tables, all must be submitted. Some can be nuill.
e Required (not null)

— CERS

— Exchange Header

— Location

— Emissions Process
— Reporting Period
— Emissions
e Optional (can be null)
— Excluded Location Parameter
— Regulation
— Operating Detalils
— Control Approach, Control Measure and Control Pollutant
— Supplemental Parameter
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Required - CERS

 Required
— User ID (EIS login)
— Usually your email address
— Program System Code
— e.g., ADEM - Alabama
— Emissions Year
- e.g., 2011
e Optional
— Model
— Model Version
— Emissions Creation Date
— Submittal Comment
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Required - Exchange Header

 Required
— Author Name (not ID)
— Organization Name
— Document Title (EIS)
— Data Flow Name (EIS v1 0)
— Submission Type (QA or Production)
— Property-Data Category (Nonpoint)
e Optional
— Keywords
— Comments
— Property-NCD Data File (Only when submitting NCD)
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Required - Location

 Required

— State/County FIPS, Tribal Code, OR Census
Tract ldentifier,

— AND Shape Identifier (CMV and Rail)
e Optional
— Location Comment
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Required - Emissions Process

 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,
— AND Shape Identifier (CMV and Rail)

— Source Classification Code
— Emissions Type Code (Used for CMV)

e Optional
— Process Comment
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Required - Reporting Period

 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,

— AND Shape Identifier (CMV and Rail)
— Source Classification Code

— Reporting Period Type Code

* Annual, monthly, 5 month ozone season, episodic,
winter, summer day

« At a minimum, you must report annual (*A”)
e Optional
— Calculation Parameter Type Code (I, O, E)
— Calculation Parameter Value and UOM (activity)
— Calculation Material Code (fuel consumed or material)
— Calculation Data Year (year of data if different)
— Calculation Data Source (Source of activity data)
— Reporting Period Comment
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Required - Emissions

 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,

— AND Shape Identifier (CMV and Rail)
— Source Classification Code
— Reporting Period Type Code

— Pollutant Code
— Total Emissions and UOM
— Emissions Calculation Method Code
e e.g., 8=AP42 ef, 3=material balance
e Optional
— Emission Factor, Numerator and Denominator
— Emission Factor Text
— Emissions Comment
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Optional - Operating Detalls

 Required
— State/County FIPS, Tribal Code, OR Census Tract
|dentifier,
— AND Shape Identifier (CMV and Rail)
— Source Classification Code
— Reporting Period Type Code
e Optional
— Seasonal Throughput

» All 4 seasons must be reported
e Total must equal 100
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Optional — Excluded Location
 Required
— State/County FIPS, Tribal Code, OR Census
Tract Identifier,

— AND Shape Identifier (CMV and Rail)

— Location Type Code
e TC —Tribe
e CTl - Census Tract Identifier
— Location Parameter
e Tribal Code or Census Tract Identifier
e Optional
— Location Comment
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Optional - Control Approach
 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,

— AND Shape Identifier (CMV and Rail)
e Optional
— Control Approach Description or Control Approach Comment
— Percent Control Approach Capture Efficiency
— Percent Control Approach Effectiveness

 Adjustment to the control effectiveness to account for failures
and uncertainty that affect actual performance of control

 EPA default =0.80
— Percent Control Approach Penetration
* % of category expected to be complying to the reg
o If reporting Control Approach
— Control Measure — Required
— Control Pollutant - Required
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Control Measure

 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,
— AND Shape Identifier (CMV and Rail)

— Control Measure Code (Device or Practice)

e Can have multiple Control Measures for a
given Control Approach
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Control Pollutant

 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,
— AND Shape Identifier (CMV and Rail)

— Pollutant Code
e Optional

— Percent Control Measure Reduction Efficiency
e Can have multiple pollutant records
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Optional —
Supplemental Parameter

 Required
— State/County FIPS, Tribal Code, OR Census Tract Identifier,

— AND Shape Identifier (CMV and Rail)
— Reporting Period Type Code

— Supplemental Calculation Parameter Type

e Heat Content, Percent Sulfur Content,
Percent Ash Content

— Supplemental Calculation Parameter Value

— Supplemental Calculation Parameter
Numerator and Denominator

e Heat Content must be BTU or E6BTU
e Optional

— Supplemental Calculation Parameter Data Year, Data Source
and Comment
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Creating XML File via the Bridge

Tool

File Help

Select one:

(") Generate blank staging tables

@Zunvert populated staging tables to CERS XML

() Canver k CERS ¥ML ko skaging tables

Select the Data Category being
converted.

Data Category: |Facility Inventory

Source Fle: *.mdb

Browse for Access file and select “Start”.

REMEMBER: The Bridge Tool works on Access 2003. If your file is saved as
Access 2007 or later, you will need to do a “save as” to Access 2003 prior to
using the Bridge Tool.
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Common Bridge Tool Errors

« XML validation failed due to the following:
Invalid byte 1 of 1-byte UTF — 8 sequence.
— This error Is usually cased by a special

character that may have been introduced if
you used cut and paste.
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Common Bridge Tool Errors

e Widows and orphans
e Duplicate records
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Submitting the zipped XML File

e Two methods
— Node-to-node

— CDX web client (most common method)
e https://nodewebrss.epa.gov/user/Login.aspx
 Use Gateway login and password

QA and Production Environment

— QA Is always open to check your data. Does not
change anything in the EIS

— Production submission is your official submission
and will update the EIS

— Recommend always sending to QA first
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/= Exchange Network Web Client v2 - Windows Internet Explorer provided by EPA

@gf - |E, https: ) fnodewebrss, epa, govfuserfLogin, aspx

File Edit ‘“iew Favorites Tools  Help

ﬁ&unvert = P select

V|§|¢f X |Gu:u:u;||e |p'

f‘i’ "1'9? [ E Exchange Metwork Web Client vz ] ‘

fi - B - o= - |hpage - O Tooks -
U.S. Environmental Protection Agency

Contact Us

Please Sign In.

] |nmbrnw5ki.sally@epa.gnu|

Passward |nu"" |

Domain | default v

default

| Privacy and Security Motice | Contact

Last updated on Tuesday, January 31st, 2012
URL: hitp://nodewebrss.epa.goviuser/Login.aspx

& Local intranet Fo100% v



= Exchange Network Mode v2 - Windows Internet Explorer, provided by EPA

@;‘; - |g, https:fnodewebrss . epa.govfuserLogin, aspx V| % | (| % | | £~

File Edit ‘“iew Favorites Tools  Help
%Cunvert - Select

i:? EIQ? [@Exchange Metwork Mode v ] ‘ ‘ﬁ < B E.%g i l-_{,"Eage - ':[- Tools -

U.S. Environmental Protection Agency -

Welcome to the Node 2.0 Web Interface

RSS/ATOM Mews Channel: |Recnveryf3hannel V| RSS@ATOM O
My Activity RSS Channel: Recovery
ﬂ}‘ Euenest Published Date: Tue, 31 Jan 2012 08:17:30 0500
ccoun
Y Last Built Date: Tue, 31 Jan 2012 08:17:30 0500 =
News Channels
News Composer Description: Recovery Channel for interfacing to Recovery.gov
B Data Exchanges Language: en-us
R,ECD,V,EW A DA lmm ANAT A2 4404 ACAN
EIS - 1 {
— SEIeCt EIS frOm the Ieft hand Slde b?aéc'nfxery.gw submitted on January 30, 2012
wWCIT Tue, 24 Jan 2012 13:12:16 -0500
EPA Weekly Financial and Activity Report for January 24, 2012
= Operations This is the EPA Weekly Financial and Activity Report for Recovery gov submitted on January 24, 2012
Download Tue, 17 Jan 2012 13:47:35 -0500
Submit EPA Weekly Financial and Activity Report for January 17, 2012

This is the EPA Weekly Financial and Activity Report for Recovery gov submitted on January 17, 2012
.. Tue, 10 Jan 2012 10:18:21 -0500

Solicit EPA Weekly Financial and Activity Report for January 10, 2012

Execute This is the EPA Weekly Financial and Activity Report for Recovery gov submitted on January 10, 2012
Tue, 03 Jan 2012 12:43:13 -0500

EPA Weekly Financial and Activity Report for January 03, 2012

) This is the EPA Weekly Financial and Activity Report for Recovery gov submitted on January 03, 2012
Il S inl Tue, 27 Dec 2011 13:40:18 -0500

R55 Search EPA Weekly Financial and Activity Report for December 27, 2011

Full Text Search This is the EPA Weekly Financial and Activity Report for Recovery_ gov submitted on December 27, 2011
Tue, 20 Dec 2011 11:34:57 -0500

Query

= Searches

Service Search
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= Exchange Network Node v2 - Windows Internet Explorer, provided by EPA

@;; - |@, https:ffnodewebrss . epa.govfuser/EIS, aspx

o &%)

File Edit ‘“iew Favorites Tools  Help

%Cunvert - Select

T::i’ EIRI" [ @ Exchange Metwork Mode w2

My Activity

My Queries

My Account
News Channels
News Composer

= Data Exchanges

Recovery
ElS

FRS
WCIT

= Operations

Download
Submit
Query
Solicit

Execute

= Searches

Service Search
History Search
RS55 Search

Full Text Search

|2

fi- B

pb v |iPage + () Todls - >

-

EIS v1 0 Data Exchange

Select Document:

Emails to Notify:

Exchange Network Web Client v2.0

|[ Browse.. |

Browse for your ZIPPED XML submission file.
Then complete your email notification. This can be more
then one email address. Then select “Submit”.

U.S. Environmental Protection Agency

{Show Help...)

(£

Done

& Local intranet Fo100% v
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Email Notifications

First email, from “CDXNotification”, immediate
— Transaction Status: Pending

Second emaill, also from “CDXNotification” , when EIS
completes processing

— Transaction Status: Completed. Feedback report is available at
EIS Gateway

Third emall, from “noreply” (EIS Gateway) , on quarter hours
— Status : Completed or Failed

* Wrong file submission error — Usually a zipped Access file is
submitted instead of the xml file

* Window closed error — “User, agency, submission year not
authorized”

o Completed might be for an XML file containing no data

Go to EIS Gateway and read the Feedback Report and
resolve any critical errors and Potential Duplicates



The Feedback Report

e Summary Page
— Name of submitter

— What environment submissions was made to
e QA or Production

— Data Category submitted
* Nonpoint
— Total number of critical and warning errors.
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Component
Location

ExcludedLocationParameter
LocationEmissionsProcess
ControlApproach

Regulation

ReportingPeriod

OperatingDetails
SupplementalCalculationParameter

Emissions

Total

Feedback Report
Statistics

Added

28676

30016

Updated
0



Feedback Report

Critical Errors
 The most important page of your feedback
report

 All critical errors must be resolved prior to
submitting to Production

— Or you might have problems
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When will my data show up In
EIS?

 Nonpoint data on the Gateway Is available
Immediately

* Reports available the next day
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Nonpoint/Onroad/Nonroad
ﬂ Emissions

IJ-L'\
@.\ o * | httpsifeis.epa.gov/eis-system-webfprocessiareal search. html i~ % || X |-

ﬂ" EIS - Windows Internet Explorer provided by

File Edit ‘Wew Favorites Tools Help

%Convert - ESelect
W | @es [ f - B - o - [hPags ~ G Tooks -

8l

| ViEw/ADD/EDIT Nonpoint / Onroad / Nonroad Emissions Search

» Facility Inventory and

Point Emissions WARNINGS
» Potential Duplicate — The selected search criteria yield more results than can be displayed. Please refine your search.
Fa Search Criteria
< » Nonpoint! Onroad/
Nonroad Emissions States » NC
Counties » All counties selected.
Tribes » All tribes selected.

» NCD Activity Data

Data Categories » Nonpaint
Sectors All sectors selected.

E

| REPORTS

Source Classifications = All source classifications selected.

» Request Reporis

» Report Downloads Shc,w entries search: [ NG

» Large File Download

Source Classification <« Emissions Type Code o FIPS State and County o v Census Tract & Shape ldentifier 2
» Feedback Repor‘ts

» Agency Submission 2102001000 37001
History Report 2102002000 37004
2 10 arom
REFERENCE DATA 5102005000 37001
» Reporting Code 2102008000 27001
Tables 2102007000 270
» QA Checks 2102008000 arom
» EIS Bridge 2102011000 3rom
2102012000 37om
SUPPORT ‘ 7103001000 37001

» View All Showing 1 to 10 of 200 entries First Previous 1 "2 73 "4'"5 "Next "Last

Announcements . o
) Edit Search Criteria 2

% Local intranet H100% v
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Editing Emissions

= EIS - Windows Internet Explorer provided by EPA

@.\-— y~ |g https: ffeis, epa.qov/eis-system-webfprocess/areafemissions html? arealocationId=- 1 §939%scc=2 1 02002 000&emission V| %J 2| X |

Ele Edit Wiew Favorites Tools  Help

%Convert - @Select

ﬂ? ﬁ'ﬁ? I@EIS ]_‘ & - D F;; e l-_.;\"Eage - .,f;‘}Tgols - »
Facilities ~ Reporting Periods: Select one or more Data Sets to view emissions - [
#» Nonpoint/ Onroad/
MNonroad Emissions Show entries

» Event Emissions
» NCD Activity Data

Reporting Period % Emissions Operating Type - StartDate ~ End Date

DataSet % Inventory Year

Type Code M

REPORTS | 2002 MEI 2002 Annual 2002-01-01 2002-12-3
» Requeﬁt Repcr‘ts MNerth Carolina
» Report Downloads Eﬁ?ﬁfﬂﬁm 2008 Annual
» Large File Download HNatural Resources

2005 NEI 2008 Annual 2002-01-01 2002-12-31

» Feedback Reports 2008 W1_5 GPR 2008 Annual
» Agency Submission Showing 1 to 4 of 4 entries First Previous 1 Next Last

History Report

Download Results: C5V

REFERENCE DATA

» Reporting Code ~ Emissions
Tables

» QA Checks

North Carolina £ 5

» EIS Bridge Pollutant » Pollutant & oo - Department of 2006 NEI | 2006 | Annual & 2008 V1_5 GPR| 2008 &
type Code > Environment and Natural o o h Annual
SUPPORT Resources | 20051 Annuai

- CAP ca Carkeon Monoxide 0 TON 1.24285 LB 0TON
» View All
Announcements CAP MNOX N'rtrugen Oxides |:| 5 5 273384 LB UTON
» View Support CAP NH3 Ammonia 0 TON 0.00745583 LB 0 TOM
Requ estg CAP PM25-PRI PM2.5 Primary (Filt + Cond} 0TON 0.606415 LB 0TON
» Create Support CaP PM10-PRI P10 Primary (Fitt + Cond} 0TON 324084 LB DTON
Reguest cap voc o e 0 TON 00124265 18 0 TON |

| ACCOUNT DATA | rap 2n7 Sylfisr Minvids n TN 15 7065 | R nTAN b

“-_-g Local intranet HoA00% -+ I



Editing Emissions

{2 EIS - Windows Internet Explorer provided| by EPA

@.\_ i |g, hktps:/feis.epa.gov/eis-system-webfemissions view. htmlPemissionsId=305045187 V| % | || X | | R~

File Edit ‘iew Favorites Tools Help

%Convert - @Select
= 3 — _ == 33
W & |@es = By - B deh v b Page - ( Took <

Il ’_‘L

Sally Dombrowski; Morth Carnclina Department of Environment and Matural Resources; Authenticated Role, S/L/T User Role - £ ||||| — e ' 2 L,‘gh
e i s == = u FELLE L - L S ¥F i i/

{5 A0N1 | L=

‘ VIEW/ADD/EDIT | Emissions Detail

» Facility Inventory and
Point Emissions ¢ Location

» Potential Duplicate * Emissions Process
Facilities + Reporting Period

» Nonpoint/ Onroad/
Monroad Emissions

» Event Emissions Pollutant: Carbon Monexide
Total emissions: 0.0

* Emissions

Edit Emission

» NCD Activity Data Delete Emissions

Emissions Unit of Measure: TON

REPORTS Emissions calculation method: & - L'SEFA Emission Factor (no Control Efficiency used)

Emissions factor: 1.0
» Request Reports Emissions Factor UoM (Numerator): TON
» Report Downloads Emissions Factor UoM (Denominator): TOMN
» Large File Download Emissions factor text:
Comment:
Last updated from: Phyllis Jones
Last updated by agency: Morth Caralina Department of Environment and Natural Resources

Last updated on: 2011-02-17 0514 FM

» Feedback Reports

» Agency Submission
History Report

REFERENCE DATA
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» Reporting Code
Tables

| £
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Adding Emissions

= EIS - Windows Internet Explorer, provided by EPA

EEX

@@ - |g https: ffeis. epa. gov/eis-system-web processfarea/emissions. html? areal ocationId=-18939%scc=21020020008&emission V| %J 5 || X |

File Edit ‘ew Faworites Tools

ﬁConvert - @ Seleck

Help

W e [@EIS

[ h- B

[;ég - l-_lf_"Eage - "; Tools -

Bt

[ TIC VT OO DT T [

» Facility Inventory and
Point Emissions

» Potential Duplicate
Facilities

» MNonpoint/ Onroad/
MNonroad Emissions
» Event Emissions

» NCD Activity Data

REPORTS ‘

» Request Reports

» Report Downloads
» Large File Download
» Feedback Reports

» Agency Submission
History Report

REFERENCE DATA

Process Emissions

» Location
+ Emissions Process

v Reporting Periods: Select one or more Data Sets to view emissions

Show entries

Reporting Period + Emissions Operating Type

Dataset Inventory Year
- Type Code

3
' Start Date

2 EndDate I

2002 NEI 2002 2002-01-01 2002-12-31
North Carelina

Dot o0

Natural Resources

2005 MEI 2005 2002-01-m 2002-12-31
2008 V1_5 GPR 2008

Showing 1 to 4 of 4 entries
Download Results: CS5V

First Previous

1 HNext Last

» Reporiing Code

~ Emissions

4l

Tables i
» QA Checks
. Pollutant =~ Pollutant 3 North Carolina Department of Environment and Natural Resources | 2008 | -
» EIS Bridge T LT ST—_ Annual
SUPPORT CAP co Carbon Monoxide 0TOMN
CAP NOX Nitrogen Oxides 0TOMN
» View Al CAP NH3 Ammonia 0 TON
Announcements - -
CAP PM25-PRI PK2.5 Primary (Fitt + Cond) 0 TON
» View Support : : :
Remsats CAP PK10-PRI PII10 Primary (Fitt + Cond} 0TON v
&) Lacal intranst 100% v
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= EIS - Windows Internet Explorer provided by EPA

Emissions

@\ ~ ) = | hitps:ficis cpa.uvieis system webjperiodjview.htmreportingPeriodld=16794057 N E [[2]-
File Edit Wew Favorites Tooks Help
@ Convert + [ Select
w & IQEE I_I f3 - B = - hpsge - ([ Tack -
-
VIEW/ADDI/EDIT Reporting Pericd View | L
» Facllity Inventory and .
Point Emissions +Location

» Potential Duplicate
Facilities

» Nonpoint/ Onroad/
Monroad Emissions

» Event Emissions
» NCD Activity Data

REPORTS

» Request Reporis

» Report Downloads
» Large File Download
» Feedback Reports

» Agency Submission
History Report

REFERENCE DATA

» Reporting Code
Tables

» QA Checks
» EIS Bridge

SUPPORT

» View All
Announcements

» View Sunnort

+ Emissions Process

~ Reporting Period

Reporting Period Type: Annual
Emissions Operating Type Code:
Inventory Year: 2008
Reporting Agency: North Carolina Department of Environment and Natural Resources
DataSet: MNorth Carolina Department of Environment and Natural Resources

Add Emissions

Start Date: 2 EIS - Wind | Expls ided by EPA
End Dato: - - Windows Internet Explorer provided by 1
Material Code: Employee @.\7 | v |g https ) ieis epa.govisis-system-weblemissions/add, html?repartingPeriodld=167 9405 78 eportingPeriod=16794057 V| 4 | 5| % ‘ ‘ f|=
Calculation Parameter Type: Existing =
Calculation Parameter Value: 22657.0 _E”e R L0 GEods b G
Calculation Parameter UOM: EACH @convert - [ Select
Calculation Data Year: B e— = -
w o I@EIS ] I £ - B - = - EkPage - (G Tooks -
Calculation Data Source: )

Comment: ~ L

Last updated from: Phyllis Jones VIEW/ADD/EDIT Add Emissions

Last updated by agencyj North Caru\maIDepanmem of Environment and Natural Reg » Facility Inventory and
Lastupdated on:  2011-02-17 05:14 PM Point Emissions

T ———— » Potential Duplicate
Facilities
» Reporting Period Supplemental culation Parameters .
» Monpoint/ Onroad/
+ Control Approaches MNonroad Emissions
» Event Emissions

+ Location

+ Emissions Process

+ Reporting Period

~ Emissions

@ Pollutant: | —select v

» NCD Activity Data # Total Emissions:

-
REPORTS & Emissions Unit Of Measure: ‘739\9,37 v‘
» Regquest Reporis & Emissions Calculation Method: ‘_Sa\a’j_ v‘

» Report Downloads Emissions Factor:

» Large File Download
» Feedback Reports

» Agency Submission
History Report
Comment:

REFERENCE DATA L

» Reporting Code
Tables

» QA Checks
» EIS Bridge

SUPPORT

» View All
Announcements

Emissions Factor UOM (numerator): ‘ —Select— v ‘

Emissions Factor UOM (denominator): ‘_se\ed_ v‘

Emissions Factor Text:

Dane ®J Local intranet w00 v



Agency Submission History Report

= EIS - Windows Internet Explorer provided by EPA

IH'\ IH\.
Q@ - |E. https:feis. epa. govfeis-system-web/reportsfanalysis/ agencySubmissionHistor sy, html V| %J 4[| % | | Felbs

File Edit Wiew Favorites Tools  Help

@ convert ~ [ Select
T 4 [@EIS ]_I f - B d=h o+ o) Page + 0 Tools -

ko d

EIS Gateway

Sally Dombrowski; MNorth Carclina Department of Envircnment and Matural Resources; Authenticated Role, S/L/T User Role :
B T . BN L i ]| JL e

| VIEWADDEDIT |

» Facility Inventory and .
Point Emissions Easeleckimenionpe

» Potenti Duplcate Select the inventory year of
Facilities Inventory Yea interest
b Nﬂﬂpﬂiﬂt-" Onroad/

MNonroad Emissions
Show entries search: [

» Event Emissions

izati Region o Facility . o 2 2
i Agency Organization b o Onroad 3
» NCD Activity Data = = “ Code Inventory ¥ Honpoint * MNonroad  Event
REPORTS ‘ . . 2010-12-  2011-08-  2014-12-  2010-08- 2010-
gzgtzlutrl:;;llma Department of Envirenment and Matural e A HE TG 5i 55 TEHTE T NIA gz-:;
» Request Reports P I i) PIY o1

» Report Downloads Showing 1 to 1 of 1 entries R e

» Large File Download

Download Results: CSV

» Feedback Reports

— » Agency Submission
History Report

REFERENCE DATA
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» Reporting Code
Tables

b

I
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e 4 I@EIS I_]

Agency Submission History
Report

@.\-— 3 - |§, https: ffeis.epa. gov/eis-svskem-webfreportsfanalysisfagency County Count . hkml?inventoryYear=2005&agencvIld=-114 Vl % || | 2|~

/= EIS - Windows Internet Explorer provided by EPA

Fil=  Edit Wiews  Favorites Tools  Help

%Convert - @Select

3

=l

EIS Gateway

Sally Dombrowski; Morth Carclina Department of Envino e

| ViEw/Apo/EpiT | Agency County/Tribe Count Report

» Facility Inventory and

Point Emissions ~ Agency/Data Category Context
» Potential Duplicate Agency Description: Morth Carclina Department of Environment and Matural Resources
Facilities

Data Category: HMonpoint

» Monpoint’ Onroad/ Inventory Year: | 2008

MNonroad Emissions

» Event Emissions — — searcn: [

» NCD Activity Data

g

. - - Unigue Processes I Unigue Pollutants - Unique SCC/Pollutants 2> 8
C Mribal N _ w -
REPORTS Ej o :“’"'T“ bal  County/Tribal Name Count Count Count
» Request Reports 37001 Alamance 120 43 285
»» Repor‘t Downloads 37003 Alexander 119 7 242
. aroos Alleghan 118 7 235
» Large File Download ghany
3rooT Anson 119 F 242
»
Feedback REDOITS aroos Ashe 118 7 235
» Agency Submission 37011 Avery 118 7 235
History Report
ry P Iroia Beaufort 118 s 235
REFEREMCE DATA 3ar01s Bertis 119 7 242
. IroT Bladen 118 s 235
» Reporting Code
Tables Brunswick 118 7 235 M
e
Done 2 | ocal intranet L 100% v I



Agency Submission History
Report

e - - - - ‘:'ﬁ;h

stern-web/reports/i O ~ @B G X H & ms < |

-
LILE e

@' J| 2 https://eis.epa.gov/ei

: Go 3[(’ - '.‘ Search ~ |- More »» SignIn 9 ~
U | VIEW/ADD/EDIT | | Agency County/Tribe Pollutant Count Report i
» Facility Inventory and Point
Emissions ~ Report Context
a » Potential Duplicate Facilities Agency Description: Alabama Department of Environmental Management
» Merge Processes Data Category: Monpoint
L ) (= 01001 - Aut AL
» Nonpoint/ Onroad/ Nonroad — LAnAE
m Emissions Inventory Year: 2008 «
» Event Emissions
> » NCD Activity Data Show entries search: [ [ D AR
H » Inventory Selection SCC Emissions Type Code Pollutant Count > Expected Pollutant Count 3>
2102001000 10 0
I | REPORTS 2102002000 10 0
» Request Reports 2102004000 10 0
u » Report Downloads 2102005000 10 0
» Large File Download 2102008000 10 0
2102007000 10 0
» Feedback Reports 2102011000 ™ 0
q » Agency Submission History 2103001000 10 0
Report 2103002000 10 0
ﬁ | REFERENCE DATA 2103004000 P ;
] 2103005000 10 0
» Reporting Code Tables
n 2103006000 10 0
» QA Checks 2103007000 10 0
m » View Dataset Identifiers 2103011000 10 0
» Inventory Cycle Management 2104008100 k5 0
» EIS Bridge 2104008210 54 0
m 2104008220 56 0
| SUPPORT | 2104008230 54 0
: » Administration Console 2104008310 54 0

= I NRD) FED -Pna




w do | get data out of EIS?

- — - — e

ystem-web/reports/: O ~ @ B & X HC_} S < ‘ ‘

a‘_ '|§,‘ https://eiz.epa.gov/ei

x Go g[t’ A "' Search = | More »»

7 reports providing details of different aspects of the Facilty Configurations, across all Agencies, fiterable by geography, NAICs, Facilty Type, Oper Status or Reg

Faciy Configuration Code. Only EIS identifiers provided.

» Request Reports

Report Downloads - Emissions Snapshot

» Large File Download All Emissions data elements in CERS XML format for Point, Monpoint, Onroad, Monroad, or Event emissions. Can be run for either S/LUT Agency reported emissions or for USEPA emissions

» Feedback Reporls datasets. Data is returned at Process 1D of SCC level detail. Snapshot updates can be requested and will be generated overnight.

o i Report Hame Report Description
» Agency Submission History -
Repor‘c By Responsible Agency Point, Nenpeint, Onroad, Monroad, Event emissions data for a single S/UT AgencyDs jurisdiction. Beth EIS and S/UT Agency identifiers are provided
By Facility Type Point emissions data for all facilties which have been tagged as a single specific Facility Type. Only EIS identifiers are provided.

REFERENCE DATA

» Reporting Code Tables = Emissions Summaries

» QA Checks Emissions data aggregated to various levels of detail in a flat file C3V format. Can filter by pollutant, geographic area, Facility Type, MAICS, regulations, sector or Source Classification
Codes. Request run every 15 minutes.
» View Dataset [dentifiers Report Hame Report Description
» ‘nVEntOI’V Cycle Management cility Point emissions data at facility, unit, process, or release point level. Both EIS and S/UT Agency identifiers are provided.
» EIS Bridge ( By Geography ) Point, Nenpoint, Onroad, Menroad or Event emissions data at National, Regicnal, State/Tribe or County geographic level
S o / -
UERORY ‘ - Event Comparisons
» Administration Console _
Report Hame Report Description
» View All Announcements
Event/Event Comparison Provides a comparison for events that may have been reported in more than one data set.
» View SUDDM Requests Event/Monpoint Comparison Provides a comparisen of emissions where event related emissions may have been reported in both the Event and MonPoint data categories.

» Create Support Request

- Downloads

ACCOUNT DATA

Report Name Report Description

» My Account
Large File Download Also located under Reports on the Gateway sidebar, a set of full US emissions summaries and SMOKE flat files already generated and available for download.

» My Agency

Report Downloads Alzo located under Reports on the Gateway sidebar, reports requested for download as well as reports requested by other users within your agency can be found
» Account List here.

» Current Users List

» Account Request List
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Reports — Emissions by
Geography

& | https:{/eis.epa.gov/eis-system-web/reports/geographicAggregate/criteria, htrml Vl % | [ %

{= EIS - Windows Internet Explorer provided by EPA

p———

e
| =¥

File Edit \View Favorites Tools Help

%Convert - @Select

¢ dhr [@EIS ]_l 0 v B @ v [k page v {0F Took -

¥

| VIEW/ADD/EDIT Emissions Summaries by Geography (CSV)

» Facility Inventory and

Point Emissions Report Criteria
» Potential Duplicate Report Type = a Report Type is required.
Facilities Data Set » aData Setis required.
» Nonpoint! Onroad/ Pollutants » atleast one Pollutantis required.
Monroad Emissions Geography = All geographic regions included.
» Event Emissions Sectors » All Sectors Selected.
» NCD Activity Data
y ~ Report Type
REPORTS
» Request Reports Report Type
» Report Downloads Naticnal by Data Category
» Large File Download National by Sector
» Feedback Repor‘ts National by Source Classification

Regional by Data Category

» Agency Submission -
HiStOW Repor‘t Regional by Sector
Regional by Source Classification

State/Tribe by Data Category

REFERENCE DATA

» Reporting Code State/Tribe by Sector
Tables State/Tribe by Source Clas=ification
» QA Checks County by Data Category
» EIS Bridge County by Sector
County by Scurce Clazssification
SUPPORT |
» View All

Announcements + Data Set or Selection i

2 ~ - T — b/
Dore %J Local intranet #100% - I
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Reports
Emissions by Geography

(= e

o-. — - S S
@.. . stem-web/reports/t O ~ @B G X H S X
x Go gh:' - '.‘ Search ~ | More>> Signln 9 ~
| VIEW/ADD/EDIT Emissions Summaries by Geegraphy (CSV)
» Facility Inventory and Point T
Emissions eport Lriteria
» Potential Duplicate Facilities Report Type » County by Source Classification
» Merge Processes Data Set » 2008-2008 V2_0 GPR
» Nonpoint/ Onroad/ Nonroad Pollutants » atleast one I.:'ollut.antisf required.
Emissions Geography » All geographicregions included.
L Sectors = All Sectors Selected.
» Event Emissions
» NCD Activity Data + Report Type
» Inventory Selection ~ Data Set or Selection 1
JER LIS show 10~ entries Pearch:joor ) |

» Request Reports

» Report Downloads
» Large File Download
» Feedback Reports

» Agency Submission History
Report

REFERENCE DATA

» Reporting Code Tables

» QA Checks

» View Dataset Identifiers

» Inventory Cycle Management
» EIS Bridge

| SUPPORT

» Administration Console

Data Set or Selection «  Inventory Year ~ Data Set Hame
Selection 2009 v1 GPR
Selection 2008 2008 V1_5 GPR
Selection 2008 2008 V1_7 GPR
Selection 2008 2008 V2_0 GPR
Selection 2008 2008 V2_0 Point GPR

Showing 1 to 5 of 5 entries (filtered from 503 total entries)

+ Pollutants

¥ Regions

+ Counties
+ Data Categories
+ Sectors

+ Source Classifications

Run Report Request Download

First Previous 1 HNext Last

s FEN DY

2:32PM
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Reports

Emissions by Geography

{Z EIS - Windows Internet Explorer provided by EPA

@.‘\— y - & | https:ifleis epa,govfeis-system-web reports/geographicAagregate/criteria, html V| % | 2| % | 2~
File Edit Wiew Favarites Tools Help I
%Convert - @Select
e it [@EIS I ] -8 g - |:kPage + {LF Tools -
» Potential Duplicate Report Type » Mational by Sector Ay
Facilities Data Set » 2008-2008 V1_5 GPR
» Nonpoint/ Onroad/ Pollutants » NOX
MNonroad Emissions Geography = All geographic regions included.
» Event Emissions Sectors = All Sectors Selected.
» NCD Activity Data
¥ » Report Type
REPORTS | » Data Set or Selection
» Request Reports ~ Pollutants
» Report Downloads 0 0 =
P Select Al All Active All CAPs Active CAPs All HAPs Active HAPs 16 HAPs None
» Large File Download
g Show entries Search: [nox |
» Feedback Reporis
Pollutant Type a  Pollutant Code Pollutant Name % Status -
». Agency Submission CAP co Carbon Monoxide Active
History Report
CAP NOX MNitrogen Oxides Active
REFERENCE DATA | HAP 94757 2,4_Dichlorophenosxy Acetic Acid Active
» Reporting Code Showing 1 to 3 of 3 entries (filtered from 471 total First Previous 1 HNext Last
Tables entries)
» QA Checks s
!
» EIS Bridge Run Report Request Download
SUPPORT |
» View All
Announcements
» View Support
Requests
» Create Support
Request
I 1 I
Done % J Local intranet #100% - I
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Reports — Emissions by
Geography

= EIS - Windows Internet Explorer, provided by EPA | |E|

@@ - |é, https: |/ feis. epa. goveis-system-web/reportsfgeographicAggregate/criteria. htrml V| % | [ % | pe i
File Edit View Favorites  Tools  Help I
%Convert - @Select

w g [@EIS l_l i;:\ﬁ | QEA - l-_,r_“’Eage v 0k Tools - ?
| VIEW/ADD/EDIT | _

Emissions Summaries by Geography (CSV)

» Facility Inventory and

Point Emissions oL

» Potential Duplicate Report Type » National by Sector

Facilities Data Set = 2008-2008 V1_5 GPR

» Nonpoint' Onroad/ Pollutants = NOX

Menroad Emissions Geography » All geographic regions included.
» Event Emissions Sectors » Fires - Agricultural Figld Burning

» NCD Activity Data

» Report Type

REPORTS | + Data Set or Selection

» Request Reports > Pollutants

» Report Downloads ectars

» Large File Download Show entries Search::
» Feedback Reports

»_ Agency Submission Agricufture - Crope & Livestock Dust
History Report

Agricutture - Fertilizer Application

REFERENCE DATA

Agricutture - Livestock Waste

» Reporting Code Bulk Gaszoline Terminals

Tables Commercial Cooking

Dust - Construction Dust

» QA Checks

Dust - Paved Road Dust

» EIS Bridge
Dust - Unpaved Road Dust
SUPPORT Fire= - Agricultural Field Burning
» View Al Fires - Prescribed Firez
Announcements Showing 1 to 10 of 59 entries First Previous 1 2 '3 4 5 Next Last ]
» View Support b’

I
%J L ocal intranet o - I
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Emission Summary
by Geography

= EIS - Windows Internet Explorer provided by EPA

@ | ¥ | @] https:fieis.epa.goveis-system-web reports/gengraphicAggregate/ criteria, html hd % 4| X Folhs
File Edit ‘Wew Favorites Tools  Help I
%Convert - ﬁSelect
"r. i (E - 2 - e \lo (9]
W o | @es [ - B deh o~ [hPage - (0 Tools -
~
| ViewAooEDiT |

Emissions Summaries by Geography (CSV)

» Facility Inventory and _

Point Emissions Reportenien

» Potential Duplicate Report Type = Mational by Sector

Facilities Data Set » 2008-2008 V1_5 GPR

» Nonpoint/ Onroad/ Pollutants » MOX

Nonroad Emissions Geography » All geographic regions included.
» Event Emissions Sectors = Fires - Agricultural Field Burning

» NCD Activity Data

Scientific Notation

Show entries

REPORTS

» Request Reports
Sectors
» Report Downloads

» Large File Download Fires - Agricultural Field Burning

Showing 1 to 1 of 1 entries

» Feedback Reporis
» Agency Submission Download Results: CSV

History Report Edit Report Criteria Request Download

REFERENCE DATA

Emissions Operating Type

searcn: [

NOX 2
(TON)

8927.9510

~
w

First Previous 1 MNext Last

» Reporting Code
Tables

» QA Checks
» EIS Bridge

SUPPORT

» View All
Announcements

» \iew Sunnorf
Done

W
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eport Downloads

{= EIS - Windows Internet Explorer provided by EPA

@ o |§, hktps: feis .epa, gov/eis-system-web reports/downloads list, html

B

File Edit Yew Favorites

%Convert - @Select

Help

WA I-_@EIS

r,ég - l-_;}'Eage - Q- Tools -

EIS Gateway

Sally Dombrowski; EIS; Content Manager Role, Authenticated Role, Inventory Selector Role, Invel

ory Developer Role, Account Mai

VIEW/ADDIEDIT | -
‘ Reports Available for Download
» Facility Inventory and
Point Emissions Showm entries Search: _
» Potential Duplicate :
Facilities Report Type Time Requested o Time Generated i :;:::E B
» Merge Processes .
- x State/Tribal by Scurce Classification 2012-01-31 1250 PM Ren Ryan
» Nonpoint! Onroad/ :
MNonroad Emissions B, | 8 National by Source Classification 2012-01-31 12:45 PM 2012-01-31 12:46 PM Reon Ryan
» Event Emissions @ | g Matienal by Source Classification 2012-01-21 11:29 AM 2012-01-231 11:48 AN Madeleine Strum
» NCD Activity Data | g Matienal by Data Category 2012-01-31 10:31 AN 2012-01-31 10:46 AN Roy Huntley
» Inventory Selection &g Facility 2012-01-31 09:49 AN 2012-04-31 10:02 AW Antheny Ross
Report Type: Facility
‘ REPORTS Data Set: 2008-2008 V2_0 GPR
Pollutants: CO, 502, NOX, WVOC, PM25-PRI, PM10-PRI, 7438621
Request Reports States: 1N
Report Downloads @R[ Faciliy 2012-01-31 09:49 AM 2012-01-31 10:03 AM Anthony Ross
oad @4 Facility 2012-01-31 09:48 AN 2012-04-31 10:03 AW Anthony Ross
B \
Feedback Reports @R[ Faciliy 2012-01-31 09:48 AM 2012-01-31 10:03 AM Anthony Ross
» Agency Submission .
) Y ( Facil 2012-01-31 09:47 AM 2012-01-31 09:48 AN Anthen Ross
History Report s y Y
@ [ g Facility 2012-01-31 09:46 AN 2012-01-31 09:48 AN Anthony Ross
REFERENCE DATA | | ooy Py |
b oo 0 g ot ¥ =y
Done % Local intranet E00% v I



How does EPA Check
Your Data?

 EPA compares submitted data to alternate
data (like EPA data) if applicable and to
previous yrs.

— Note that for sectors that span both point and
nonpoint, compares sector level data (as
opposed to SCC level)

— Point /nonpoint overlap of emissions.
e Qutliers
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How Is the NEI created?

General Purpose Release (GPR)

Data Merge (Selection) — The datasets are put in an
order for the purpose of selecting only one datum per
FIPS, SCC, and pollutant code

— State/local/tribal data used preferentially

— EPA data used for gap-filling

PM Augmentation — Fills in missing PM species.

— Example, SLT submits PM10-FIL but not PM2.5-FIL
— In 2008, this was a manual method

EPA estimates



Recap - 2011 Changes

e Codes added/retired

— Retiring Dioxins/furans
* 141 (benzene soluble organics),
e 142 (methylene chloride soluble organics),
e 626 (Dioxins/Furans as 2,3,7,8-TCDD TEQs -1/89)

e 627 Dioxins/Furans as 2,3,7,8-TCDD TEQs -
WHO/98

« 600 Dioxins/Furans as 2,3,7,8-TCDD TEQs - TEQ
scheme unspecifiedNew QA checks
— Adding
* 628 (Dioxins/Furans as 2,3,7,8-TCDD TEQs -
WHO2005)
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Recap — 2011 Changes

QA Checks — changed to critical
— CMV
 Emission Type Code required for CMV
— PM

« PM2.5 must not exceed PM10
 If PM2.5 reported, PM10 must be reported

e QA Checks - new
— HAP groups
» Total group pollutant can not be reported at the

same process as specific pollutants belonging to
the same group.
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Contacts

e Submittal Issues

— Sally Dombrowski
dombrowski.sally@epa.gov; 919-541-3269

e |[nventory Issues

— Roy Huntley
nuntley.roy@epa.gov, 919-541-1060

— Laurel Driver — CMV and Rall
driver.laurel@epa.gov, 919-541-2859
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